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Micro Focus COBOL Server 4.0 Release
Notes
These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.
Note:
•

•

This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link.
Web sites by their nature can change very rapidly and although we try to keep our links up-to-date,
we cannot guarantee that they will always work as expected.
Check the Product Documentation section of the Micro Focus SupportLine Web site for any
updates to the documentation which might have been uploaded.

COBOL Server provides the execution environment for applications created with any IDE variant of Visual
COBOL.
Updating from earlier versions of COBOL Server
Note: This applies to Windows platforms only.
Due to an internal change in version 4.0 of your product, you must at least relink any executable programs
compiled prior to this version, to make them compatible with the latest run-time system. However, a full
recompilation of your source code is the recommended action, to allow your executables to benefit from the
product's latest programming and performance enhancements.
Relinking an executable without recompiling means using the original object code with the cbllink utility,
using Visual COBOL 4.0. Original object code is typically the binary file output (usually containing the .obj
extension) produced during the original compilation process. An application can contain one or more binary
files.

4

| Micro Focus COBOL Server 4.0 Release Notes

What's New
This release provides enhancements in the following areas:
•
•
•
•
•
•
•
•

Application Server JCA Support for Enterprise Server
Data File Tools
Docker
Enterprise Server
File Handler
Managed COBOL
OpenESQL
Platform support

Application Server JCA Support for Enterprise Server
Back to Top
This release includes the following enhancements:
•
•
•

COBOL Resource Adapters now support WebSphere 9.0 and WebLogic 12.2.1.
Tomcat 7.0 support for servlet generation with J2SEBeans.
NullSearch utility - for COBOL resource adapters, this new utility provides assistance in locating NULL
fields in mappings passed to Enterprise Server. When a large number of arguments is provided in the
parameters passed to Enterprise Server, it is difficult to locate NULL fields, which are not allowed. The
NullSearch utility isolates NULL fields, so the Java application can be corrected.

Data File Tools
Back to Top
It is now possible to export any filtered results. When filtering a data file, you can use the results to create a
new data file - click Search > Export Results when a filter is applied to save the filtered records to a new
file. You can:
•
•
•
•

Save the filtered records to a new file.
Save the records that match the specified filter (such as customer information or orders).
Download a subset of the data from a remote file.
Save a small portion of the data for testing purposes.

Docker
Back to Top
This release provides support to enable you to run your COBOL applications in Docker containers, taking
advantage of the many benefits offered by the Docker platform such as portability, performance, agility,
isolation, and scalability.
Enterprise Server
Back to Top
The following enhancements have been made to Enterprise Server:
•

Conversation filtering - the Enterprise Server Communications Process (MFCS) can now restrict access
to listeners by client address. You can specify any permitted or forbidden addresses either by IP
address, network mask, or domain name, and use wildcards. Filters can be applied to individual
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listeners, communications processes, or to entire regions. More specific filter rules override any general
ones.
•

The Enterprise Server Security Facility now starts throttling Verify requests when it receives more than
100 requests per second.
This can be used to limit the effectiveness of denial-of-service and brute force attacks. You can
configure the value where throttling occurs. See Verify Request Throttling for more information.

•

(Technology Preview only) Support for adding, deleting, and modifying XA resources in a live Enterprise
Server region.
It is now possible to add, edit, or delete XA resources while an enterprise server instance is running.
Any changes made come into effect after any in-flight transactions have completed. The ability to make
these changes in a live environment comes under the control of the existing enterprise server
permissions.

•

XA-compliant Resources (XARs) - this release provides enhanced CTF tracing that allows more flexible
reporting of warnings and errors on the RM switch module level.

•

A new Communications Server resource class - enables you to control the access to the Enterprise
Server Console Log and Communications Server Log when external security is in effect for an
enterprise server region; see Resource Classes for Communications Server for more information.

•

Improved catalog availability - there is now an improved resilience to temporary communication issues
with the catalog and error reporting enabling a region to stay active if a region has multiple catalogs
defined and one of the catalogs is not available.

•

Enhanced SSL/TLS certificate support - for communications with TLS (formerly SSL), additional
certificate and key file formats are supported. Servers may now be configured with both an RSA and an
ECC key and certificate.
Enhanced SSL/TLS cipher configuration - for communications with TLS (formerly SSL), the permitted
cipher suites and their preferred order can now be configured. The minimum size of Diffie-Hellman
groups for DH key exchange can also be configured. The defaults have been made more secure.

•

•

•

The Historical Statistics Facility (HSF) now enables you to write user-defined data to the records
produced within a .csv file. Use the ES_WRITE_CUSTOM_HSF or ESCSTHSF library routines within
your COBOL programs to define the custom data, and use the ES_HSF_CFG environment variable to
configure up to five custom fields in the generated record.
You can also use the ES_HSF_CFG environment variable to configure the number of CICSF, TSQ, and
TDQ fields that are written to the record.

File Handler
Back to Top
This release provides the following enhancements:
•
•

The DFSORT and SYNCSORT emulations now support the NULLOFL parameter of the OUTFIL
statement.
The ASCIISOSI configuration option is now available. It adds the required SOSI characters to the
relevant EBCDIC DBCS character strings in order for them to be displayed or written out correctly.

Managed COBOL
Back to Top
Deploying JVM COBOL to an Application Server:
•
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Running JVM COBOL under WebSphere 9.0 and WebLogic 12.2.1 is now supported.

OpenESQL
Back to Top
This release provides the following new features:
•
•
•
•
•

Support for SQL Server 2017.
The SQL(TRANSACTION) compiler directive has been enhanced to clearly define transaction
boundaries.
A new SQL(NOWHERECURRENT) compiler directive that allows you to define updateable cursors that
do not do positioned updates or deletes with PostgreSQL or MySQL.
Larger communication area (PID) that accommodates longer plan and program names.
SQL(OPTIMIZECURSORS) has been enhanced for consistent and better cursor performance across all
OpenESQL backends.

Platform support
Back to Top
Note the following changes in platform support for this release:
•

Windows 8 and Windows Server 2012 are no longer supported for developing applications. They are
still supported for deployment. Windows 8.1 and Windows Server 2012 R2 are supported.

•

SUSE platforms - this release only supports SUSE Linux 12 SP2, 64-bit.
On this platform, you can only build COBOL programs to 64-bit executables. This applies when using
Eclipse on SUSE or with remote projects when is installed on SUSE.
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Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.
Where present, the numbers that follow each issue are the Support Incident Numbers followed by the
Reported Problem Incident (RPI) number (in parentheses).
•
•
•
•
•
•
•
•
•
•
•
•

Code Coverage
Codeset Support
Common Communications Interface
Communications Server
Data Tools
Documentation
Enterprise Server
Enterprise Server Auditing
File Handling
MF Server Administrator (GUI)
Micro Focus Directory Server
Run-Time System

Code Coverage
Back to the list
•

Schema changes that affect the test coverage results generated from the tcutil utility mean that if
you propagate the results to a third-party application (for example, an XSLT processor), and rely on the
<copyFileCoverage> element, you need to alter your transformations to focus on
<sourceFileCoverage> instead. The element was renamed to more appropriately reflect its
contents, as tcutil now gives global coverage for all source files (not just copybooks).

Codeset Support
Back to the list
•

•

Code-set mappings between ASCII and EBCDIC have been updated when Simplified Chinese is the
language in effect. ASCII table 5210 now maps to EBCDIC CCSID 836 for SBCS conversions. This
replaces the previously conversion (where ASCII table 1042 was used), which would convert the “\”
character to “$”.
3124321 (1111464)
New single-byte character set tables for MFCODESET have been added in order to improve support for
DB2 LUW - both for off-mainframe databases and for access to z/OS DB2. A number of existing
MFCODESET mappings have also been updated. See 'Supported Country Codes' for a full listing of
ASCII/ANSI <-> EBCDIC mappings.
3111843 (1109984)

Common Communications Interface
Back to the list
•
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You can now configure the Micro Focus Directory Server and enterprise server region’s listeners to only
use the server's configured SSL and TLS protocols and define a priority ordered cipher suite collection.
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This forces connecting clients to use the server’s preferred ordered list of cipher suites when using the
specified protocols.
2866265 (1105526)
•

•

In some circumstances it was possible for a connection to incorrectly accept the identity of an SSL/TLS
peer and allow a connection to complete when the connection should have been denied. This occurred
due to a failure to check the peer's entire identity certificate chain. This has now been fixed. NOTE: You
might need to correct your system’s configured certificate chains that fail verification checks at secure
connection creation time.
In some circumstances it was possible to crash the CCITCP module when it was attempting to obtain
detailed error information about a closed connection. This has been fixed.

Communications Server
Back to the list
•

•

•
•

TN3270 conversations to Enterprise Server now correctly handle the receive (idle) timeout setting
configured for the listener. There are also two new settings for configuring TN3270 timeouts, "Printers
time out" and "Output resets timeout". See the online product documentation for more information.
3144133 (1113024)
Web access to the Enterprise Server Console Log and Communications Server Log is now restricted
when the region is secured using external security. Users will be required to provide a valid username
and password in order to view either log file. Web access to the logs can be controlled using the
standard ACL definitions under the new "Communications Server" Resource Class, with resources
"Enterprise Server Console Log" and "Communications Server Log". If these resources exist, users
require read access to be allowed to view the logs. If they do not exist, the default behavior is to allow
read access. The new resource class and resource definitions can be found in the
"es_default_ldap(_msuser/_unix).ldf" file in the bin or etc sub-directory of your product install directory.
3113539 (1110155)
MFCS listeners can now be SSL-enabled without the need to have DemoCA installed.
2868627 (1105777)
MFCS no longer initializes the Security Facility if there are no External Security Managers defined for
the region.

Data Tools
Back to the list
•

Records with an invalid value for a conditional field will no longer result in a match for that conditional
layout.
2853226 (1103406)

Documentation
Back to the list
•

•

You can use 'byte' or 'BYTE' as a synonym for the binary-char unsigned data type. As a result, 'byte'
and 'BYTE' are now reserved words in Managed COBOL. Use the REMOVE"BYTE" Compiler directive
to prevent an error being produced for existing programs that use the reserved word as a user-defined
word.
3147576 (1113323)
As of version 3.0, references to types within an assembly other than mscorlib need to be explicitly
referenced. You can achieve this by using the ILREF Compiler directive. (Previously, in certain
circumstances, the Compiler would allow access to types within the System.dll assembly without the
need for an ILREF"System" directive.
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3121002 (1111373)
Enterprise Server
Back to the list
•

•

•

•

The External Security Facility (ESF) can now be configured to throttle large volumes of incoming Verify
(user authentication / signon) requests to improve resilience to denial-of-service and brute force attacks.
See "Verify Request Throttling" for more information.
3113639 (1110160)
The LDIF files used to create the sample configuration for Enterprise Server LDAP-based security no
longer create an empty "PHYSFILE" resource class. Changes in the JCL engine as of ES 3.0 caused
most jobs to fail when submitted to a security-enabled region using such a configuration. See the
product help for more information.
The MLDAP ESM Module, part of the Enterprise Server External Security Facility, now supports the
Argon2 hash algorithm for creating password verifiers. See MLDAP ESM Module Custom Configuration
Information in the product help for more information. NOTE: The Argon2 hash is optional and not
enabled by default.
The MQ pages in ESMAC are now controlled by a new security resource, MQL. This enables you to
either restrict or grant users access. 'MQL*' is a new resource that needs to be added under MFESMAC
similar to existing resources such as 'PCT*' or 'XAT*'. The following is a sample export of the LDAP
repository:
******************************
# Sample security definitions for ESMAC MQ Listeners/Writers pages
#######################
###### MQL*
##
#######################
dn: CN=MQL*,CN=MFESMAC,CN=Enterprise Server Resources,CN=Micro
Focus,CN=Program Data,DC=X
changetype: add
cn: MQL*
objectClass: microfocus-MFDS-Resource
microfocus-MFDS-Resource-Class: MFESMAC
microfocus-MFDS-Resource-ACE: allow:SYSADM group:alter
microfocus-MFDS-Resource-ACE: deny:*:execute
microfocus-MFDS-UID: mfuid
#description: Allow full access any ESMAC MQ Listeners/Writers Screen
******************************

•

•

•

3143258 (1112990)
You can now use the ECIResponse.getReturnCode() method to obtain the return code for any errors
from Enterprise Server.
3142092 (1113248)
Communication with the console daemon has been improved. Messages are displayed more quickly
and requests are being processed more efficiently and, as a result, times for initialization and shutdown
might be reduced.
3136867 (1112483)
Administrators can now add, delete or modify XA resources in the Enterprise Server Administration
Web UI while a region is running.
2589624 (1085625)

•

In UNIX environments, DB2 and ODBC switch modules can now be enabled together in the same
region if the DB2 switch is built with the "-o" option.
3137455 (1112398)
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Enterprise Server Auditing
Back to the list
•

•

The maxRetryTime value in the audit configuration file now treats 0 as a no timeout time, and any
negative number as an infinite timeout.
3150566 (1113592)
Any extra information that was added to the syslog messages will now correctly appear in the structured
data items.

File Handling
Back to the list
•

•

In some cases the ESF LDAP Security Administration Web Interface inadvertently removed users from
groups when changing their password. This has been fixed.
3124294 (1111259)
The ESF LDAP Security Administration Web Interface can now filter by Class and Resource name,
description, and ACL. Previously, you could only filter on Class name.
2871549 (1106119)

•

•

For .NET applications, set XFHLOG=DEFAULT to create the XFHLOG file in the current directory;
otherwise it is created in C:\ProgramData\Micro Focus\[ED/VS]\[Release]. From release 4.0 onwards,
this variable also has an effect for native applications.
3115116 (1110323)
Setting the configuration option ASCIISOSI=ON will adds the required SOSI characters to the relevant
EBCDIC DBCS character strings, in order for them to be displayed or written out correctly.

•

3113802 (1110183)
The OPEN mode of SYSOUT files now honors the DISP specified in the JCL.

•

3109432 (1109745)
OPEN I-O of a virgin ESDS file now correctly returns a file status of 35, as it does on the mainframe.
2887724 (1108443)

MF Server Administrator (GUI)
Back to the list
•

The total number of active sessions or clients in MFDS is now limited to 2000.

Micro Focus Directory Server
Back to the list
•
•

•

The mfds -g options D, O, and S have been added to the product Help.
2848627 (1102864)
On UNIX, specifying an invalid user ID in the MFDS "General" options value for "Default process user
ID" no longer causes the child process (such as a region start or stop request launched from the Web
interface) to fail. The user ID under which the MFDS process was started will be used instead.
MFDS now disables and limits the scope of Web listeners on add. It also emits a warning if any
insecure Web listeners are displayed in the validate and listener tables.

Run-Time System
Back to the list

Significant Changes in Behavior or Usage
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•
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The run-time system now produces a more precise error message if a shared object of the wrong bitism
is loaded.
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Known Issues
Refer to the Known Issues and Restrictions topic in the Product Information section of your product Help.
In addition, note the following:
•
•
•
•
•

Commuter licenses
Enterprise Server
imtkmake
Installation
OpenSSL

Commuter licenses
If there are a number of entries displayed in the License Administration tool, these might be either for
different products or for the same product but for different serial numbers, for example.
When a commute request is made using the license manager, that request is serviced from a pool of
licenses that could be provided by any number of Micro Focus product licenses stored on that server. The
commute request cannot target a particular RMS license by product name, serial number, or number of
cores.
The products to which you apply the commuter licenses will be licensed correctly but the number of
licenses left in the License Administration tool might appear to be less than expected. This issue is more
likely to occur with multiple entries for the same product.
If you are using a number of different products, Micro Focus recommends that you use a different licensing
server for each product in order to help minimize the issue.
Enterprise Server
•

On Windows 10, if you are using Microsoft's EDGE browser to access the Enterprise Server
Administration GUI, issues with EDGE can cause the automatic refresh feature to display a dialog
asking whether you want to resubmit a form. To work around this issue, cancel the resubmit request and
then refresh the server list page or the Home page of Enterprise Server Administration. You can also
turn off the automatic refresh by setting the Auto-refresh interval setting on the Home page of
Enterprise Server Administration to 0.

imtkmake
•

On AIX v7.2, you must install IBM's patch APAR IJ04075 in order for imtkmake -genclient to work
correctly. See http://www.microfocus.com/docs/links.asp?vc=IBM_APAR_IJ04075 for details about how
to install the patch.

Installation
•

Installing this product fails if Micro Focus License Manager version 10000.2.02070 (April 2015) or older
is already installed on your machine. The setup files does not upgrade the License Manager
automatically to the latest version. You must uninstall the existing version before you start the
installation.

OpenSSL
The version of OpenSSL included in Visual COBOL and Visual COBOL 4.0 is intolerant of expired X.509
certificates in the CA Root Certificate collection in some circumstances. Specifically, if you configure a PEM
file that contains multiple certificates as the collection of trusted CA certificates, and one or more of the
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certificates in that file have expired, OpenSSL might not be able to load and use other certificates in the file
which are still valid. This can cause certificate validation errors and connection failures for SSL and TLS
connections.
To work around this, you need to remove any expired certificates from such collections. If necessary,
replaced them with any valid certificates that have the same Distinguished Name and Modulus (key). This
is a known issue with OpenSSL. Micro Focus is investigating for other possible workarounds.
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Resolved Issues
The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Adis
COBSQL
Codeset Support
Common Communications Interface
Data Tools
DB2
Documentation
EJB Generation
Enterprise Server
File Handling
J2EE Connector
Java Support for COBOL
MF Common Client
Micro Focus Directory Server
Micro Focus Cryptographic Library
OLE Class Library
OO Base Class Library
Run-Time System
Setup Issues
SQL: HCO for SQL Server
SQL: MBDT Utilities
SQL: OpenESQL
XML Support

Adis
Back to the list
•

•

•
•

When running under DIALECT"RM", a DISPLAY statement using the WINDOW-CREATE clause will
create a window. Its position can be relative to the parent window or the screen. The position specified
will be the upper-left position of the first character in the window. If the window has a border specified,
the border will not change the location of the first character on the window.
3143230 (1112975)
By default, the ZERO-FILL SCREEN SECTION clause only affects alphanumeric items when the data is
modified in an ACCEPT statement. For compatibility with ACUCOBOL-GT, Adis includes a new
selection (#3) to the option '16 Force Field to be updated if it is not altered'; it reads: 3: Alphanumeric
fields with the ZERO-FILL clause are updated even if the field is not altered.
3137641 (1112412)
JUST (and RIGHT-JUSTIFY) now works when specified in the data item for a CONTROL clause.
3137065 (1112350)
Internal limits that would cause a 'COBCH1990-S Internal error - Code generation of SCREEN
SECTION exceeded 65535 bytes for large SCREEN SECTION' message have been removed.
3130462 (1112572)

Resolved Issues

| 15

•

•
•

•

•

Box line characters no longer disappear when using DISPLAY WINDOW BOXED and the background
contains DBCS characters.
3125337 (1111261)
The window1 preprocessor now correctly handles underscores specified as part of a data item.
3123437 (1111084)
When using the Window1 preprocessor to support DISPLAY WINDOW ACUCOBOL-GT syntax, Keisen
and reverse-video attributes are now supported. Note: Due to the way that the attribute system works
on a Japanese OS, to make space for Keisen attributes, background-color attributes are not supported.
3123217 (1111064)
To emulate RM/COBOL behavior, an additional action affecting the left- and right-cursor keys within a
field has been added to ADISCTRL. Setting 25 contains a new action (value #3) that emulates the
behavior of generating an exception when trying to move beyond the left- or right-hand edge of an entry
field. However, unlike RM/COBOL, where you can control the exception generation of the left and right
cursor keys individually and specify the exception values generated, this action affects both keys, and
the values generated are fixed. They are 3 for the left arrow key, and 4 for right arrow key.
3115797 (1110548)
The PROMPT identifier in a SCREEN SECTION now works as expected.
3115743 (1110380)

COBSQL
Back to the list
•

A problem that caused COBSQL to mishandle EBCDIC conversion when the program was called more
than once has been fixed.

•

3145943 (1113226)
A problem that caused incorrect indentations in generated code when using the KEEPCOMP directive
has been fixed.

•

3144736 (1113124)
A problem with COBSQL handling of spaces between the colon and the host variable name has been
fixed.

•

3144632 (1113283)
A problem with COBSQL incorrectly handling the AMODE directive has been fixed.

•

3144632 (1113257)
COBSQL now correctly handles host variables with the same name that are defined in different groups.

•

3139017 (1112553)
KEEPCOMP will now check SQLCODE for FETCH statements before performing a byte order swap on
COMP data items.

•

3138321 (1112476)
A problem with COBSQL correctly handling replaced lines greater than 72 characters in length has
been fixed.

•

3127369 (1111465)
COBSQL failed to recognize declared host variables that were identified using a two-part name. This
has been fixed.

•

3127102 (1111417)
A problem that caused the COBSQL preprocessor to incorrectly handle the WORKING-STORAGE
SECTION statement has been fixed.
3124957 (1111232)
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•

An occasional problem with COBSQL reinitialization that caused the second background parse to fail
has been fixed.

•

3124170 (1111154)
The COBSQL preprocessor was not handling COPY... REPLACING... statements correctly, causing the
Debugger to display incorrect information. This has been fixed.

•

3123903 (1111140)
A problem that caused COBSQL to fail to parse the PROCEDURE DIVISION statement correctly when
part of the statement was in a copybook has been fixed.

•

3122593 (1111019)
A problem that caused the COBSQL preprocessor to fail to generate HSF trace data When either the
EBCDIC or KEEPCOMP option was specified has been fixed.

•

3120860 (1110883)
A problem that prevented COBSQL from processing more than 150 lines of similar source code in a
single source file has been fixed.

•

3112520 (1110134)
A problem that caused the COBSQL preprocessor to incorrectly process child items when either the
KEEPCOMP or EBCDIC options were specified has been fixed.

•

3110932 (1110772)
A problem that prevented the COBSQL preprocessor to correctly process data groups when the
KEEPCOMP directive was specified has been fixed.

•

3110932 (1110575)
A problem that caused COBSQL to fail to recognize all data items correctly when the host variable was
a group item has been fixed.

•

3110932 (1110650)
A problem that prevented COBSQL from correctly recognizing the parents of some data items when the
KEEPCOMP directive was specified has been fixed.
3110932 (1110495)

Codeset Support
Back to the list
•

The current Shift-JIS EBCDIC to ASCII support under MFCODESET=81,930,939, and 9122 is based
on the Japanese International Standard (JIS) X 0208 1978 revision. New conversion tables have been
added based on the JIS X 0208 1990 revision - the tables have been taken from IBM's Conversion
Tables CCSID 300 - 941. To use these new conversions instead of the default ones, set
MFCODESET_DBCS=941.
3143604 (1112980)

Common Communications Interface
Back to the list
•

An intermittent failure to establish a TCP connection with various components (including CCITCP,
COBOL service deployment, and JCL job submission) was caused by the EADDRINUSE error. This has
been fixed.
3123202 (1111222)

Data Tools
Back to the list

Resolved Issues
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•

The /d parameter of the DFSTRCL command line utility is no longer case sensitive.
2989512 (1108654)

•

Applying a filter to a data file after selecting a field no longer causes the editor to crash.

•

3139552 (1112637)
Large structure files can now be loaded within the editor.

•

•

3122802 (1111101)
When performing a filter more than once, the filter no longer encounters a 9/41 corrupt indexed file, and
the correct navigation buttons are enabled. Additionally, the filter now shows the correct number of
filtered records.
2883777 (1110293)
The Data File editor now enables you to export filtered results to a new data file: option Search>Export
Results when a filter is in effect.
2878521 (1107103)

•
•

DFCONV now shows its version number, rather than "TEST", when used from the command line.
3114824 (1110281)
Classic Data File Tools now supports IDXFORMAT(12). You can create files of this format, and use the
Data File Convert tool and DFCONV command line utility (including .pro files) to convert to and from
this format.
3113772 (1110180)

Documentation
Back to the list
•

•

•

•

•
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The documentation now states that the ILSMARTLINKAGE directive is only for use with procedural
COBOL programs, not COBOL classes.
3147500 (1113420)
The product help now clarifies that cblcored.exe requires write permission to the current user’s
HKEY_CURRENT_USER key in the Windows registry. This ensures that any changes to the Core
Dump settings made with the utility will persist.
3142772 (1112972)
The IMS Tracing Flags topic has been updated to accurately reflect the options available in Enterprise
Server.
3142342 (1113320)
An important distinction has been made in the documentation, in that the content of nonnumeric literals,
comment lines, comment entries and data can include any of the 'printable' characters available in the
current character encoding scheme. See the 'Character Set' topic of the Language Reference Manual
for more information.
3140851 (1112720)
The 'Standard File Header' topic now states that the definition is not applicable to certain indexed file
formats. The definition of the node sizes, as specified in the 'Index File - File Header' topic, has also
been clarified so that it applies to all applicable MF index file formats.

•

3140352 (1112840)
The ACCEPT statement documentation now contains the possible values codes/definitions returned for
EXCEPTION STATUS.

•

3138691 (1112556)
The documentation now documents the difference between MF COBOL and RM/COBOL when
inspecting the EXCEPTION STATUS in an ACCEPT statement.

| Resolved Issues

•

3138691 (1112555)
Documentation for the SPZERO Compiler directive now directs you towards the preferred replacement,
SIGN-FIXUP.

•

3135675 (1112227)
The order in which the File Handler searches for the File Handling configuration file has been correctly
documented for UNIX and Windows platforms.

•

3132391 (1111933)
The use of the INTLEVEL Compiler directive has been clarified in the documentation; that is, it is an
internal directive, not intended for customer use.

•

3129661 (1112191)
If mnemonic-name is associated with ENVIRONMENT-NAME in an ACCEPT or DISPLAY statement, its
value must not exceed 255 bytes.

•

3126506 (1111354)
A restriction has been documented for the X"B0" Function 2 library routine, where console applications
cannot distinguish between the left and right Shift key presses.

•

3125717 (1111316)
The documented example for OO switches has been updated to remove an obsolete switch.

•

3117356 (1110506)
A new syntax rule (#9) has been added to the CALL statement topic in the Language Reference
Manual, stating the restriction of passing a floating point item BY VALUE in native COBOL.

•

3115091 (1110326)
The documentation for the BELL directive has been corrected to state that it is checked during the
syntax checking phase, and not at the generate phase.

•

3110088 (1109799)
In the documentation, the steps required to customize ASCII\EBCDIC character set conversion have
been clarified.

•

3108884 (1109682)
More information has been added for file and project level problem error markers. See Maximum
Number of Problem Error Markers for more information.

•

2881233 (1107671)
An error has been corrected in the description of the "Go To Procedure Division" option in the "Making
the Most Out of The COBOL Editor" topic.

•

2877216 (1106910)
Documentation for 'COBRT181 Invalid parameter error' has been expanded to include a possible cause
and solution for the error.

•

2876095 (1106782)
The instructions on how to install Fileshare as a Windows service have been clarified - see
'Walkthrough - Fileshare as a Service' in the product docs.

•

2876085 (1106746)
The product help now clarifies that adding the Micro Focus Runtime (Interop RuntimeServices)
assembly adds the MicroFocus.COBOL.RuntimeServices reference to a Visual Studio project.

•

•

2850791 (1103124)
The Sharing Database Connections Between Java and COBOL topic has been updated with an
example showing object sharing with other languages both when Java opens the connection and when
COBOL opens the connection.
2674454 (1091949)
The ANSI92ENTRY topic has been updated to include OpenESQL behavior in corfomance with the
ANSI-92 standard.
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•
•
•
•
•
•
•

•

•

•
•

•

•

2596163 (1086171)
The SQLCODE Values topic has been updated to reflect the most current information available.
2593799 (1085947)
When compiling tests on UNIX, you should include the -U COB flag.
The error message description for COBCH1558 has been expanded to include the possible scenario of
when a difference in bitism (between Java version and compilation mode) has caused the error.
The COBCH1006 error message text has been corrected to encompass the fact that different dialects
have different limits for the length of a COBOL word.
The documentation has been corrected to state that the LINKLIB directive is not required by the cobol
command. (LINKLIB was an old directive that should no longer be used.)
The Codecomp Utility documentation now states that you can only create customized tables for singlebyte character sets.
An incorrect reference to SYSREC has been removed from the example in the topic "SQLTP2 Utility Executing Dynamic SQL Statements".
3145877 (1113167)
When using the MVSSPLHK spool housekeeping process to override the retain period of a class; for
example: CLASS A 003 Y this refers to the output dataset class, and not the job class.
3138584 (1112576)
The instructions on running the SPOOL conversion tool (splconv) have been updated with
recommendations for setting the MFSYSCAT_ERRS variable. This is because there are a number of
errors generated whilst running the conversion that can be safely ignored, and setting this variable to a
sufficient value will allow the conversion to complete successfully.
3124350 (1111280)
Documentation for MFJSABCODE has been added to the Sort environment variables.
When running the dfconv command line utility, the (optional) -d option must be the first parameter
specified in order to have an effect.
3135598 (1112570)
The product help about "Datetime Literals in SQL Statements" now correctly states that to enable the
functionality, you need to code any of the specified SQL comments into your DB2 mainframe
application, positioned before a literal declaration.
3133502 (1112053)
For Fileshare through Enterprise Server, on UNIX systems, Micro Focus recommends that CCI TCP in
loopback mode is used in preference to CCI Named Pipes (CCINAMPU), because support for
CCINAMPU is deprecated.

•

3131680 (1111868)
The "UNIX and Linux Installers Issues" topic in the product help included an incorrect parameter, "EDadminID=[User ID]". This now correctly states the parameter as "-ESadminID=[User ID]".

•

3129927 (1111675)
Where appropriate, the SYNCSORT and DFSORT documentation now links directly to the topic that
explains the various field types in use.

•

3123796 (1111143)
Error message BMSCH1099W has been documented.

•

3122477 (1111005)
The topic that lists the Compiler directives restricted in Managed COBOL has been brought up to date.

•

3120358 (1110789)
In the documentation, the entry point/parameter name corrected for the UNIX version of the INITCALL
directive.
3104480 (1109719)
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•

•

Information on the TCLS Entity has been added to the product documentation. See Resource Classes
for ESMAC and Operator Command Security for more information.
2913474 (1108497)
The documentation now references the es_default_ldap.ldf file, which contains a working example for
using the DATASET resource class.
2860914 (1104513)

EJB Generation
Back to the list
•

A problem that caused EJB client generation to fail when processing OCCURS arrays has been fixed.
3131411 (1111877)

Enterprise Server
Back to the list
•
•
•

Starting the MFDS process with the -r option will now disable the Web administration UI. If using a
browser to connect to the MFDS TCP network address, you now receive an HTTP 403 response.
A missing form name in some Enterprise Server Administration pages could result in a JavaScript error.
The default options under ESMAC > Resources now depend on the Region options. If JES is installed,
the new default resource to show under Resources is JES. If IMS is installed, and JES is not installed,
then IMS is the default. If MQ is installed, and both JES and IMS are not installed, then MQ is the
default. If iFS is installed, and each of JES, IMS, and MQ are not installed, then iFS is the default.
Otherwise, the default resource is Services.
2871166 (1106098)

•
•

•

•

•

•

An issue using single sign-on between MFDS and ESMAC has now been fixed.
3106232 (1109779)
The Enterprise Server External Security Facility (ESF) has improved redundant / failover support for
Security Managers. See "Security Configuration Custom Configuration Information" in the product help
for more information.
2990790 (1109080)
The Enterprise Server External Security Facility's MLDAP ESM Module can now generate an audit
event describing the "effective rule" that determined the decision (allow / deny / permissions set) for an
Auth or XAuth request. The effective rule is the security rule that was used to make the decision. See
“MLDAP ESM Module Custom Configuration Information” in the product documentation for more
information.
2887945 (1110096)
Enterprise Server Security trace message 2003, emitted when a SAFROUTE(Auth) request is made
with the "API trace" flag enabled and access to the resource is denied, no longer truncates long
resource names. Long names are abbreviated but still provide the prefix and suffix of the name.
2885856 (1108682)
Enterprise Server's External Security Facility, when using LDAP-based security, has an "Update"
mechanism that can be used to notify MFDS and running Enterprise Server regions of changes to
security information. This now works correctly for changes to group membership, for example, when a
user is removed from a group.
2873024 (1106452)
Depending on the sequence of login, users with long usernames that contained spaces and that had
usernames similar to other users could login and find that they are treated as if they do not have the
correct user permissions. This has now been fixed.
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•

In Enterprise Server, when using LDAP-based security, if a user belonged to a group with an LDAP
wildcard character (such as "*") in its name, and there were nested groups defined, and the use-allgroups mode was enabled, groups that contain other groups could be incorrectly added to the user's
group set. This has been fixed.

•

mfds and casstart will now run successfully on machines with locale names with the @modifier part,
such as fr_FR.iso885915@euro.
2868439 (1105641)

•

Extended ECI LUW context is now maintained.

•

3148577 (1113418)
Using the dump command from an MQ listener resulted in an AB/BA lock.

•

3146317 (1113217)
In 64-bit environments, ECI requests that do not use ES_ECI_SOCKET to identify or locate the target
region used to fail.

•

3143232 (1112962)
A request made with valid credentials no longer fails after an initial request that returned an error ECIERR-SECURITY-ERROR.

•

3142092 (1113220)
The Data File Editor now supports DSNs that contain the '£' and '#' characters.

•

3140182 (1112661)
The casstop /w command no longer creates a ccierr.log when a region terminates during the /w delay.

•

3135994 (1112257)
Previously, when creating a new DFHDRDAT, the provided users had an invalid phrase setup which
resulted in sign-on errors.

•

3135433 (1112238)
When a job that performs an EXCI LINK without the SYNCONRETURN option was submitted twice in
succession, the second job did not run successfully.

•

•
•

•

3125864 (1111322)
An issue with DFHJSON where JSON data would not be written to a container has been resolved.
3121607 (1110917)
The casutl command line utility supports a new option, /x, which enables you to switch the active trace,
dump and/or hsf files. For more details, see your product's documentation.
3120728 (1110848)
When recycling SEPs in a busy JES system, jobs that have not run yet are now managed correctly.

•

3120670 (1111235)
In a busy system, if JCL jobs timed out or were cancelled, the local trace entries could sometimes
corrupt the shared memory causing the region to become unresponsive.

•

3116835 (1110501)
Mapping structures to containers in DFHJSON when there are consecutive multiple empty elements
now works as expected.

•
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3129348 (1111596)
previously, HSF records for tasks that executed prior to a switch of the active file could be written to the
newly active file. This has been fixed so that records are written to the file that was active at the time the
task ran.

| Resolved Issues

3114815 (1110285)
If the result length from a call to CBL_CCSID_CONVERT was smaller than the original buffer length,
garbage was written at the end of the buffer. This was because the length used was the original length
and not the length returned from the call.

•

3114365 (1110223)
A FREEMAIN of a shared pointer which had been populated in a SEP other than the one attempting the
free would provoke a trap.

•

3112416 (1110196)
When either a CPMT NEW COPY is issued or FORCE PHASEIN is enabled on the SIT, MAPs are now
reloaded from the disk and the memory version will not be used.

•

3105813 (1109891)
System folders that have a backslash at the end of the name are now supported in region
configurations. Previously, a region would fail to start in such scenarios.

•

2886956 (1108250)
If there was an error when trying to start cobdebugremote, the port was not retrieved.

•

2864798 (1105495)
When defining a GDG model, the path is now grayed out.

•

2855374 (1103840)
It is now possible to use environment variables in MQ Listeners queue names.

•

•
•
•
•
•

•

2842137 (1102027)
If a casout -g command to retrieve relative DD for a job was issued and the resulting file had a size of 0,
the file was left open which resulted in a leak of handle.
2814439 (1098608)
An issue causing the BlueZone terminal emulator to disconnect has been resolved.
2807210 (1098676)
Requests are now aborted if the ECI luw token is invalid.
The "Use all groups" option for a secure enterprise server instance now enables the Data File Editor to
authenticate a user against all of the groups for a particular user.
Using casout with the /v option (to list initiators, printers and mprs) could cause incorrect HSF records to
be generated.
You can now use CBL_DEBUG_START and CBL_DEBUG_STOP to generate live recordings on x86
Linux platforms. You can generate consecutive live recordings from a single process, whereas
previously you could only generate one per process.
It is now possible to edit the dataset name entry in ESMAC if an incorrect name was submitted when
adding the dataset.

•

Imported hexadecimal transactions are not truncated anymore.

•

3153155 (1113813)
Fixed an issue with the admin seps terminating abnormally when a USER (who is not associated with a
group in ESM) tries to logon to ESMAC.

•

•

•
•

3152197 (1113814)
Access to the XAT resources in ESMAC (casrdo65) is now controlled by the user's security settings for
the 'XAT*' resource under MFESMAC. The user will require "Update" access to the GRP resource in
order to see the XAT Delete button.
3143258 (1112991)
TCPIPSERVICE resources are no longer erased when the URIMAP resource is set to PIPELINE. In
addition, ESMAC now accepts blank WEBSERVICE fields.
3141235 (1112752)
The deletion of a PDS member in a secure region now use the correct classes.
3140443 (1112709)
Sometimes the STOP button for connected clients in ESMAC was not displayed when security was on.
This has now been fixed.

Resolved Issues

| 23

•

3139885 (1112724)
Date and time filter values are now retained when the jobs are filtered to user requirements in ESMAC.

•

3138516 (1112498)
The Reply button for a waiting from console JOB in ESMAC is now enabled or disabled depending on
user authority.

•

3137426 (1112397)
The environment variables ES_DISABLE_DFLTUSR_SIGNON/
ES_ESM_DISABLE_DFLTUSER_ESMAC are now correctly honored in secure regions.

•

3133646 (1112061)
When specifying the ES_MAX_CATALOG_LINES environment variable, one line fewer were displayed
in the ESMAC catalog view. This has been fixed.

•

3129034 (1111563)
The 9/041 error no longer occurs when accessing catalog after running a job that accesses the proclib.

•

3122584 (1111066)
An issue in the date and time filters in the ESMAC spool display page has now been fixed.

•

•
•

3122475 (1111003)
The Job page now displays in Shift JIS encoding if the operating system encoding is determined to be
Shift JIS.
3115107 (1110311)
The SIT 'New' button is no longer greyed out when the ESMAC user has the appropriate permission.
2913474 (1108809)
If the Data File Editor was used to retrieve the DCB information for a data file hosted by Enterprise
Server and the catalog did not contain a physical filename, an RTS 114 error would be encountered.
This has now been fixed.

•

The PostgreSQL switch module now loads correctly in 64-bit mode.

•

3149380 (1113516)
A problem recovering from errors where SQL Server unilaterally terminates an XA transaction has been
resolved.

•

3145058 (1113133)
User Impersonation now works as expected when using an ODBC switch module in batch mode.

•

3140100 (1112655)
The ESMSSQL switch module no longer returns an RTS153 error if USERP=T is set and the user does
not exist.

•

3140097 (1112649)
The Oracle switch module no longer fails with an RTS153 error when being enabled after an initial
connection error.
3129198 (1111608)

•

Auditing using syslog now reconnects correctly after the syslog server restarts.

•

3135191 (1112186)
Auditing modules are now loadable on all supported platforms.

•

3124417 (1111183)
Syslog messages can now be configured to use TLS as the transport protocol.

File Handling
Back to the list
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•

Users, Groups, and Classes can once again be searched based on substring matches, rather than full
exact matches.

•

3127314 (1111414)
Password Expiry and Account Expiry dates are now correctly displayed in the ESF LDAP Security
Administration Web Interface when specifying times in 24 hour format.

•

2883964 (1107911)
The Users in the "Members" list for Groups and Groups in the "Group Membership" list for Users are no
longer incorrectly filtered by the filter on the respective "Users" and "Groups" main tabs.

•

2871547 (1106121)
The ESF LDAP Security Administration Web Interface no longer incorrectly displays a blank Users/
Groups list when changing tabs.
2863056 (1104795)

•

•

The REPRO of a cluster that contains an alternate index no longer performs the copy using the
alternate index. It uses the primary index instead.
3136566 (1112386)
When running under a mainframe emulation, if the INDD record length does not match the cataloged
length for SYSIN when performing an ACCEPT statement, and that results in a partial record being
read, that record is now returned (as it does on the mainframe).

•

3120786 (1111421)
9/41 additional statuses 2, 4, 5 are no longer printed to the log without an associated log entry for the
actual 9/41 error.

•

3115318 (1110341)
Setting RUNITLOCKDETECT=OFF no longer causes an unhandled exception when a file is opened
multiple times in managed code.

•

2885757 (1108212)
File Handler settings supplied by the extfh.cfg configuration file are now captured in CTF tracing of the
File Handler.
2849599 (1102983)

•

•

•
•

If, in a single process, Fileshare is called with both FCD2 and FCD3, the filename sent to Fileshare no
longer becomes corrupted.
3131960 (1112168)
The reading of keys no longer fails when the indexed file that was open prior to the current file was not
explicitly closed.
3129038 (1111565)
The EXTFH option RETRYOPEN has no effect when set in the Fileshare Server configuration file.
3106992 (1111699)
An SPLJNO filename will no longer become corrupted when being accessed simultaneously through a
Fileshare server currently under load.
3106992 (1112094)

•

iFileshare no longer hangs during a stop run operation if files being used in the program are accessed
through different iFileshares.
3142333 (1112939)

J2EE Connector
Back to the list
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•

You no longer receive Java heap errors when a resource adapter is passing large amounts of data.

•

3120684 (1110892)
JSP generation works correctly when there are OCCURS fields.
2869932 (1105858)

Java Support for COBOL
Back to the list
•

The Javademos Readme files have been updated with new instructions.

MF Communications Server
Back to the list
•

•

•

•

Enterprise Server and the Micro Focus Common Client now support opening more than 256 SSLenabled endpoints simultaneously. Also, a resource leak in the MFCS process for HTTPS connections
made with CICS Web Interface or CICS Web Services has been fixed.
3137166 (1112477)
A situation where some terminal emulators were unable to connect to an enterprise server region has
been fixed.
3135166 (1112195)
The maximum size of an HTTP header value allowed for a CICS Web Interface or CICS Web Services
server can now be configured. Include an [HTTP] section in the configuration information on the Edit
Communications Process page, and use the option 'maximum header value length=<num-of-bytes>'. If
not specified, the default number of bytes is 1024.
3127781 (1111480)
A bug that caused some clients to crash MFCS when submitting 3-character trancodes has been fixed.

•

3121264 (1111026)
Enterprise Server now correctly handles chunked HTTP message bodies. The CRLF sequences, which
appear after each chunk, are now removed when the chunked body is consolidated.

•

3100279 (1109784)
The Enterprise Server Communications Process (MFCS) can now restrict access to listeners by client
address. See "Conversation Filtering" in the product Help for more information.

•

2887418 (1108517)
Enterprise Server's backward compatibility with older versions of MFDS has been restored.

MF Directory Server
Back to the list
•

•
•

•

Automatic corrections are now made to invalid Enterprise Server listener ISC configurations when they
are loaded or imported.
3136730 (1112328)
Regions exported using MFDS now include the IMS query name if present.
3130077 (1111684)
A missing product HTML file could cause the Enterprise Server Administration HTML GUI to revert to
using English text rather than the configured language. This is now fixed.
3118363 (1110595)
A memory leak in the MFDS process which could cause an intermittent crash has been fixed.
2886846 (1108593)
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•

•
•
•
•

•
•

The "mfCASIMSMFSNullChar" and "mfCASIMSTMMQColdStart" IMS region attribute values are now
imported correctly from a previously generated XML export from the Micro Focus Directory Server.
2879665 (1107226)
The "IMS Configuration Directory" configuration value has been deprecated and has been removed
from the Enterprise Server Administration Web UI for Enterprise Server instance properties.
For additional security, any start, stop or not-responding region scripts region will only be executed if the
Micro Focus Directory Server restricted administration is enabled.
You could get an RTS115 error in MFDS on AIX when performing certain actions such as browsing the
properties of an ESM.
When executing Enterprise Server in a Docker container, you need to set the
MFDS_EXTERNAL_ADDR environment variable to a resolvable external address string (a hostname
rather than an IP address) in the Docker environment. This is to enable client browsers to resolve
ESMAC and other URLs in Enterprise Server Administration. The value of this variable will replace the
internal container address in the URL.
The Enterprise Server Administration Web UI "Directories" menu item and functionality has been
deprecated and is no longer available.
If MFCS control channel is configured to use SSL, MFDS must have an environment variable "MFDS_
$SERVERNAME_CAROOT" defined, which points to the full file path of the CA root certificate used to
sign the control channel's certificates.

Micro Focus Cryptographic Library
Back to the list
•

The MFDS could crash during startup when SSL and a keyfile with no password are used to secure it.
3152964 (1113791)

OLE Class Library
Back to the list
•

An issue with the tabbing of ActiveX controls has been resolved.
3106202 (1109437)

OO Base Class Library
Back to the list
•

The SortedCollection class methods setSortMethod and setSortEntry are now thread-safe.

•

3145921 (1113207)
The class libraries resources now compile without having to add the Windows SDK include location to
the INCLUDE environment variable.

•

3117380 (1110512)
Menu item objects are not destroyed until the on idle processing. This is to stop the destroying from
being attempted twice.
3107820 (1110204)

Run-Time System
Back to the list
•

When native COBOL calls a Java method that returns an array of objects, the returned object reference
now correctly represents the array of objects.
3144462 (1113127)
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•

•

•

•

3136927 (629611)
A new tunable has been introduced, dbcs_text_enable_clip, which when set to true ensures that the font
is clipped to the font height supplied by Microsoft Text APIs rather than overwriting pixels beyond the
font height. Use this tunable when running in a GUI window (runw). The default is false.
3136924 (1112338)
The NUMPROC"ACOS" directive has been enhanced to support certain elements of NEC ACOS
COBOL relating to the processing of invalid data in USAGE DISPLAY data items.
3135821 (1112242)
A bug in the NUMPROC"ACOS" emulation of NEC ACOS COBOL has been fixed. The error occurred in
statements of the form: move unsigned-display-item to numeric-edited-item where the source item
contains a negative value.

•

3135821 (1113569)
The NUMPROC"ACOS" directive has been enhanced to support certain elements of NEC ACOS
COBOL relating to invalid sign information in USAGE COMP-3 data items.

•

3135820 (1112241)
In the run-time text window, the correct key-code is now returned when the Tab key is pressed after the
Window menu has been previously selected using the Alt + Space shortcut.

•

•

•

3132989 (1111983)
The position and size of windows created with the WINDOW-CREATE clause in Dialect(RM) will no
longer be constrained by the window that was active when the call is made. Previously, a window
created by WINDOW-CREATE would be required to fit within the constraints of the parent window. This
behavior was not consistent with the same command under RM/COBOL, and so was changed.
3131065 (1111843)
A GUI application no longer fails to terminate correctly if the title bar of the text window console is
currently selected with the mouse when the termination occurs.
3124823 (1111218)
OO CTF tracing now correctly outputs the thread-id to file.

•

3117361 (1110510)
When using .INT code, an arithmetic statement involving a 64-bit COMP-5 operand now gives the
correct results.

•

3111631 (1109997)
When entering multiple DBCS characters using the IME, the later characters in the string are no longer
being corrupted. Previously, corruption occurred due to a bug in Microsoft's ReadConsoleInput() API.

•

•

•
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When creating a live recording file, if you specify a path in the COB_LIVE_RECORD environment
variable, the path is now validated (to ensure it exists) before the process runs.

| Resolved Issues

3111356 (1109909)
A new parameter is available for the CHECKDIV Compiler directive that emulates behavior when
attempting to divide by zero on an ACOS mainframe system. CHECKDIV"ACOS" will result in both the
quotient and the remainder being set to the value of the dividend if a divide by zero operation is
attempted when no ON SIZE ERROR clause is specified.
3111073 (1109890)
The NUMPROC Compiler directive has a new parameter. NUMPROC"ACOS" provides partial
compatibility with the behavior of NEC ACOS COBOL processing of invalid data in USAGE DISPLAY
data items.
3111072 (1109889)
On file systems that support 64-bit inode numbers, CTF output files were not produced in the expected
directory if its inode number was sufficiently large that it did not fit in 32 bits. This has now been
corrected.

•

•

•
•

•
•

3109110 (629772)
When using the COBOL printer routines, the default printer is now selected on Windows Server 2016.
Registry differences introduced with Windows 10/Sever 16 caused existing functions to select the wrong
default printer. These have now been updated to use an alternative method to achieve the correct
result.
3109043 (1110153)
An intermittent runtime error (COBRT255: CODESET cannot open double byte conversion table) could
occur when MFCODESET was set to a value that included double byte conversions. This has been
fixed.
3108885 (1109915)
The correct status-code definitions (for Windows and UNIX) are now recorded in the documentation.
2879887 (1107243)
Improvements have been made to the run-time system, the File Handler and the JCL engine, with
regards to error trapping and reporting.
2867927 (1106202)
Spurious errors no longer occur when compiling or running programs on 32bit Linux platforms with an
XFS file system greater than 1TB.
COBUTF8 no longer segfaults if COBDIR is not set.

Setup Issues
Back to the list
•

The DemoCA installer now works correctly on Japanese OS.

•

3142481 (1112900)
An issue with some empty folders created during installation ad not deleted when the product was
uninstalled has been resolved.

•

3115392 (1110376)
The RPM installer now displays the correct information about the Install and Update commands at the
end of RPM extract.
3108619 (1109717)

DB2
Back to the list
•

•

•

•

The DB2 preprocessor sometimes generated a 309 malformed subscript error if the SQL statement
contained COMP host variables with an indicator variable array. This has been fixed.
3142686 (1112952)
A problem that prevented the use of CBLLINK on compiled programs that use LITLINK has been fixed.
HCO now supplies the LIBs necessary to link these applications. Note: If you compile static DB2
applications that use LITLINK, you must compile them using the DB2(NOPRE) directive, and specify all
applicable LIBs in the LINK statement. For example: CBLLINK SELECT.obj DB2API.LIB,
MFHCOLIB.LIB, MFSQLSMF.LIB
3135847 (1112270)
The DB2 preprocessor incorrectly generated code to convert COMP fields in SQLCA if no SQL
statement was found in the program. This resulted in error "COBCH0002 Undefined ECM error. Inform
Technical Support. Error code 309". This issue has been resolved.
3129362 (1111619)
The DB2 preprocessor has been enhanced with a new directive option, DB2(STOPROC), that provides
a solution to a problem that prevented DB2 LUW stored procedures from working properly when
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compiled with CHARSET(EBDIC) because character information is passed to and from DB2 LUW as
ASCII data.
•

3129260 (1111614)
A problem that caused the DB2 preprocessor to generate DB103 errors on mainframe-style VARCHAR
host variable definitions has been fixed.

•

3123813 (1111337)
When run against DB2 LUW version 10 or later, the HCO DCLGEN tool sometimes defined the first
column in a DECLARE TABLE statement incorrectly by dropping WITH DEFAULT. This has been fixed.

•

3119616 (1110699)
The DB2 preprocessor and HCO runtime have been updated to convert an entire VARCHAR field to
EBCDIC rather than just converting the length of data specified. This corrects a problem with erroneous
ASCII spaces showing up in VARCHAR columns.
3110220 (1109819)

SQL: MBDT Utilities
Back to the list
•

•

DSNUTLB LOAD no longer gives an SQL error for columns that are defined as DECIMAL EXTERNAL
and that have a POSITION clause containing only a start position, but no end position.
3139744 (1112632)
A problem when that occurred when querying referential integrity information for a table has been fixed.
In addition, a problem with CompiliOptionBlock being out of sync with new ESQL directives has been
fixed.
3119350 (1111458)

SQL: OpenESQL
Back to the list
•

•

•

•

OpenESQL now supports RETURNING clauses in INSERT, UPDATE and DELETE statements when
using SQL(DBMAN=ADO) and SQL(PROCOB).
3120916 (1110849)
A problem when using an Oracle REF CURSOR in managed code that sometimes caused subsequent
statements to fail has been fixed.
3113118 (1110287)
Problems with DATE and TIMSTAMP handling when using the Oracle fully managed provider for
ADO.NET have been fixed by introducing new environment variables to control .NET formatting of
datetime and datetimeoffset values when DATE=EXTERNAL is set for Oracle connections.
3108444 (1109632)
Problems with DATE and TIMESTAMP handling when using the Oracle fully managed provider for
ADO.NET have been fixed by introducing new environment variables to control .NET formatting of
datetime and datetimeoffset values when DATE=EXTERNAL is set for Oracle connections.
3107838 (1109570)
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•

An issue with singleton selects that have no FROM clause but have a WHERE clause has been fixed.

•

3151028 (1113711)
A problem that generated an undefined preprocessor error and caused compilation to fail when a literal
of a size greater than 79 characters was used with the SQL LIKE operator has been fixed.

•

3150466 (1113596)
Previously, when using SELECT... INTO statements containing a FOR UPDATE clause with PostgreSQL
and MySQL, the pseudo column used for positioned updates was not present in tables. A new

| Resolved Issues

OpenESQL directive, SQL(NOWHERECURRENT), is now available. This benefits PostgreSQL and
MySQL applications that do not require positioned update or delete support, and where the pseudo
column used as a rowid to implement positioned updates and deletes is not present.
•

3146620 (1113335)
A problem using "plan" as an SQL identifier has been fixed.

•

3146620 (1113251)
An issue with using the SQL(XAID) Compiler directive with IMS applications has been resolved.

•

3144626 (1113137)
A problem with applications using a very large number of embedded SQL statements has been fixed.

•

3142107 (1113006)
A problem with fetching data into .NET Decimal host variables, causing an invalid overflow error, has
been fixed.

•

3134510 (1112152)
A problem handling .NET string host variables in OpenESQL applications compiled with the 64-bit
COBOL compiler has been fixed

•

3134369 (1112116)
The file cobmfdsntiar.so is now included in the COBOL Server product.

•

3132441 (1112164)
The limit for the number of compiled SQL statements has been increased from 5000 to 12000.

•

•
•

3129084 (1111593)
An inconsistency with the OpenESQL ADO.NET runtime handling of PIC X host variables in DBCS
locales has been fixed.
3128324 (1111562)
A problem with EXEC SQL ALLOCATE for SQL-CLOB host variables has been fixed.
3128295 (1111492)
OpenESQL for ADO has been updated to behave consistently with Pro*COBOL by returning a +1403
SQLCODE instead of an erroneous -1403 SQLCODE when a PL/SQL stored procedure fails to handle
a data-not-found condition.

•

3128289 (1111491)
A problem that prevented the setting of the UNSAFE_NULL directive from the IDE when using
Pro*COBOL has been fixed.

•

3127696 (1111447)
A problem with Oracle scroll cursors that resulted in a backward compatibility issue with Net Express
has been fixed.

•

3126245 (1111648)
If you use an AT db_name clause in a DECLARE CURSOR statement, you no longer need this clause
in statements that reference the cursor, such as FETCH, CLOSE, GET NEXT RESULT SET or
positioned UPDATE and positioned DELETE statements. To maintain backward compatibility the clause
may optionally be included, but it is no longer required.

•

3124001 (1111150)
A problem that caused the OpenESQL preprocessor to generate invalid code when "AT xxxx SELECT"
was specified in an array singleton SELECT statement in managed code has been fixed.

•

3123827 (1111128)
A problem with SQL(CHECK) that was introduced in version 3.0 of this product and occurred for DB2,
Oracle, and PostgreSQL with ADO.NET has been fixed.
3121267 (1110919)
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•

•

A problem using AT <connectionName> with COMMIT, ROLLBACK, and SAVEPOINT statements has
been fixed.
3115063 (1110308)
A new SQL compiler directive option, PICXBINDING, has been added to OpenESQL to provide more
intuitive behavior for LIKE expressions with SQL Server by enabling greater control of parameter
binding for PIC X host variables.

•

3113999 (1110373)
OpenESQL has been updated to retain the FOR READ ONLY clause when the TARGETDB SQL
compiler directive option is set to DB2.

•

3112785 (1111030)
A problem with fractional seconds truncation when using the legacy SQL Server ODBC driver has been
fixed.

•
•

•

3112499 (1110032)
A problem using SYSTEM_USER in select statements has been fixed.
3111513 (1109934)
A problem caused by OpenESQL rounding a result to a COMP-3 host variable instead of truncating it
has been fixed in the ODBC runtime.
3110902 (1109871)
A problem with OpenESQL trimming trailing spaces in input host variables has been fixed by the
addition of the SQL(PIXCBINDING=FIXED) compiler directive option, which ensures that these trailing
spaces remain intact.

•

3110720 (1110099)
A problem handling unmapped codepoints in DBCS locales when storing binary data in character fileds
and using SQL(ALLOWNULLCHAR) has been fixed.

•

3109266 (1109723)
OpenESQL had a storage limit of 30 characters for a program ID. The maximum has been increased to
128 characters.

•

2884875 (1107982)
A problem that caused OpenESQL to remove any OPTIMIZE FOR n ROWS clause from queries when
TARGETDB was set to DB2 has been fixed.

•

2883301 (1108387)
A problem with HCOSS access plans getting out of sync with the running code and database stored
procedures and metadata when a live ES region is updated has been fixed.

•
•

•
•

2877693 (1110926)
OpenESQL has been updated to support the OPTIMIZECURSORS SQL compiler directive option for
the OCI and JDBC run-time systems.
The SQL(TRANSACTION) directive now accepts an additional option, AUTO.
SQL(TRANSACTION=AUTO) is equivalent to SQL(AUTOCOMMIT). For new applications,
SQL(TRANSACTION) is the preferred method for specifying transaction options.
PostgreSQL versions 3.2.2 and later are now supported with .NET COBOL.
Operating System authentication for CONNECT statements is now supported for Oracle, DB2, and SQL
Server in the ODBC, ADO, and JDBC run-time systems.

SQL Option for DB2
Back to the list
•

A problem that caused an AUTOBIND support routine invoked by the XDB ECM to fail by omitting the
drive letter in log file names when the specified drive letter was other than C: has been fixed.
3114069 (1110423)
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•

The XDB ECM now supports the z/OS DB2 NEXTVAL reserved word as an ordinary identifier.

•

3120469 (1110834)
A problem that prevented the SQL Option for DB2 ECM from recognizing IN clause predicates
containing multiple group host variables has been fixed.

•

3115066 (1110310)
A problem that prevented the SQL Option for DB2 ECM from supporting the use of a collection ID for
validating SQL against z/OS DB2 with DYNAMICRULES BIND packages has been fixed.
3112996 (1110332)

•

A problem reading XDB translation files caused by stack initialization on Windows 10 has been
resolved.
3120927 (1110988)

•

•
•

A problem that resulted in an X352 thread access violation due to an improper reallocation of the parse
tree when using an inner join to a table expression containing a scalar subquery has been fixed.
3132740 (1111977)
A problem with CASE expressions resolving host variables has been resolved.
3131966 (1111932)
A problem with the lexical analysis of a PARTITION BY SIZE clause on a CREATE TABLE statement
when the integer constant and the "G" indicating gigabytes were not separated by a space character
has been fixed.

•

3129670 (1111676)
An issue with a correlated subquery not returning results due to a problem with the correlation variable
has been resolved.

•

3114811 (1110283)
A problem with the query optimizer incorrectly identifying the step for predicate evaluation of a join
predicate containing a column and an expression has been resolved.

•

3114809 (1110284)
A problem that caused an X352 thread access violation on a VIEW definition containing a select item of
the form name.* has been fixed.

•

3114210 (1110228)
An access violation caused by a long UNC path for the Roaming APPDATA directory on a Windows
machine has been resolved.

•

3112201 (1110021)
A problem that caused the XDB engine optimizer to return an empty result set for range predicates on
join conditions has been fixed.

•

3111742 (1109957)
A problem with the first FETCH operation against a rowset cursor containing a UNION ALL with host
variables has been resolved.

•
•

•

3110071 (1109893)
An issue with a LEFT OUTER JOIN operation not retrieving all result set rows has been resolved.
3104216 (1109202)
A problem with XDB engines not allowing a GROUP BY to contain an item not in the projection list has
been fixed.
3103832 (1109175)
A problem that caused a PDMP272 – xdb Inner Join Problem message has been fixed.
2887796 (1108361)
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•

The Stored Procedure Test tool now sizes the Results tab in the same way as it sizes the other tabs.

•

3148319 (1113402)
A problem with DSNUTILB that occurred when loading a table containing a VARCHAR field has been
resolved.
3128931 (1111587)

XML Support
Back to the list
•

cbl2xml will now work successfully under AIX 7 32-bit.
3109051 (1109699)

•

The XML run-time now handles UTF-16 XML documents correctly.

•

3147256 (1113357)
The XML run-time system now correctly sends the XML instance document as an HTTP POST request
to the URL specified on UNIX platforms.

•

3145761 (1113163)
An RTS 164 error (Run-Time subprogram not found) no longer occurs on some very old versions of
Windows when parsing XML.

•

3142315 (1113028)
The XML run time now correctly sends the XML instance document as HTTP POST request to the URL
specified.

•

3135893 (1112298)
XMLPARSE now returns the full UTF-8 string when XMLPARSE(COMPAT) is specified.
3126921 (1112286)
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Other Issues Resolved in This Release
The numbers listed are the Support Incident Numbers followed by the Reported Problem Incident (RPI)
number (in parentheses).
•
•
•
•
•
•
•
•

2879380 (1107250)
2881923 (1109518)
2913358 (1110961)
3145394 (1113143)
3142564 (1112892)
3129260 (1111765)
3117914 (1111288)
3143624 (1113310)

Other Issues Resolved in This Release
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Unsupported Functionality
This section includes information about features or functionality that are no longer supported.
•

36

The HOSTSIGNS Compiler directive is no longer supported. Micro Focus recommends that you use the
following Compiler directives instead: SIGN-FIXUP, HOST-NUMMOVE, and HOST-NUMCOMPARE.
This is a change since version 3.0 of this product.
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Installation
Before Installing
Downloading the Product
1. Use the download links in your Electronic Product Delivery email.
For more information follow the links for the installation instructions and the End User License
Agreement.

On Windows
System Requirements
Hardware Requirements
The disk space requirements are approximately:
COBOL Server
800MB

Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.
Operating Systems Supported
For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.
•

Support for development on Windows 8 and Windows Server 2012 has been discontinued. These
platforms are still supported for deployment. Windows 8.1 and Windows Server 2012 R2 are supported.

Software Requirements
Note:
•
•

The setup file will check your machine for whether the prerequisite software is installed and will
install any missing prerequisites and the product components.
This product includes OpenSSL version 1.0.2n.

Before installing this product, you must have the following software installed on your computer:
•

The Microsoft .NET Framework - the setup file installs the .NET Framework 4.5.2 . You might need to
install the following version of the .NET framework manually, if it is targeted by your applications:
•

Microsoft .NET Framework 2 - if your applications use the ILCLR(2) Compiler Directive or if they
target the .NET Framework versions 2, 3 or 3.5. You might need to download these installers
depending on the .NET Framework you are targeting.
To download the Microsoft .NET Framework 2 click here.
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Microsoft .NET Framework 2 or later is also required for the Micro Focus License Manager if you
install this on a separate machine as a license server.
Note:

•

• .NET Framework 3 is provided with Windows Vista and Windows Server 2008.
• .NET Framework 3.5 is provided with Windows 7 and Windows Server 2008 R2.
• .NET Framework 4.0 is provided with Windows 7 and Windows Server 2008 R2.
• .NET Framework 4.5 is provided with Windows 8 and Windows Server 2012.
• .NET Framework 4.5.1 is provided with Windows 8.1 and Windows Server 2012 R2.
• .NET Framework 4.6.2 is provided with Windows 10 and Windows Server 2016.
Microsoft's Web Platform Installer 2.0 if your application targets ASP.NET 4. This installs and sets up
ASP.NET. To download the installer click here.

•

A Web browser is required for Enterprise Server Administration in COBOL Server.

•

To use your Web browser offline, you need the dial-up networking feature of Windows installed.
Otherwise you might have TCP/IP errors such as being unable find "localhost" or the numeric equivalent
(127.0.0.1).
To use Enterprise Server Administration, scripting or JavaScript support must be enabled in your
browser. This is on by default in Internet Explorer in most Windows operating systems, apart from
Windows Server 2003. Also, active content must be allowed and not blocked. To enable both these in
Internet Explorer:

•

1. Click Tools > Internet Options.
2. On the Security tab, click Custom Level. In the Scripting section, under Active Scripting, click
Enable.
3. On the Advanced tab, scroll down the list to the Security section, and ensure the item Allow active
content to run in files on My Computer is checked.
Enterprise Server Help requires the Java Runtime Environment on some Windows systems to enable
the Search facility to work.
Important: For local servers, you do not need to install the Micro Focus License Administration tool
separately, as the setup file installs a new Visual COBOL client and a new licensing server on the
same machine.
If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool. To check the version of the license server on UNIX, run /var/
microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.
If Micro Focus License Manager version 10000.2.02070 or older is installed, it must be uninstalled
before the product installation or upgrade can continue.
You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

Additional Software Requirements
To ensure full functionality for some COBOL Server features, you might be required to obtain and install
additional third-party software in addition to the prerequisite software installed automatically by the COBOL
Server setup file.
Click here to see this information on the Product Documentation pages on Micro Focus SupportLine.
Deployment - running . NET COBOL applications from a network server
Back to Top
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For .NET COBOL applications that you run from a network server, the server must have the Microsoft .NET
Framework version 4.5.2 or later and the Microsoft Visual C++ 2017 Redistributable Runtime installed.

Installation Restrictions and Requirements
Before starting the installation, you should consider the following:
•

You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

•

Before installing this product, make sure that any existing Micro Focus Directory Server (MFDS) or
CCITCP2 Windows service (on Windows) or a process (on UNIX) from an existing product is stopped
and uninstalled. On Windows, do this as follows:
1. Stop the MFDS and CCITCP2, using either the Windows Service Management Console GUI
(services.msc) or from a command line prompt by typing:
net stop mf_ccitcp2
Only one instance of the MFDS or CCITCP2 service can run on a Windows machine.
2. Uninstall the MFDS or CCITCP2 service.
For MFDS, from a command line prompt enter: mfds -u
For CCITCP2: ccitcp2 -u
To run an earlier version of MFDS as a service after you have installed a later version:
1. Stop and uninstall the MFDS service, as described above.
2. Reinstall the earlier version, as follows:
a. Open a COBOL Server command prompt.
b. Install the service. Enter the following command: mfds -i
c. Start the service. Enter the following command: net start mf_ccitcp2
Note: The two versions use different paths for environment and registry values, so the list of
configured enterprise servers might be different depending on which version has been started,
since, by default, different MFDS data repositories are used.
MFDS 5.1 and later are able to import or use Enterprise Server configuration data generated by earlier
versions of MFDS, but 5.0 or earlier versions of MFDS might not be able to read data generated by later
versions.
It is possible to run MFDS from a command prompt ("mfds") rather than as a service, but by default the
"mfcobol" port is used (86) and this can only be used by one process at a time

Product Co-Existence
Note: The following applies to Windows only.
•

Visual COBOL and COBOL Server cannot coexist on the same machine.

On UNIX
System Requirements
Hardware Requirements
The disk space requirements are approximately:
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Platform

Installer type

Setup

Disk space

Disk space

Sentinel RMS

file size

required for

required for

license server

the installation

running
the product

POWER
running AIX

Micro Focus

398 MB

1.59 GB

796 MB

41 MB

HP IA

Micro Focus

764 MB

3.13 GB

1.53 GB

79 MB

System Z
Micro Focus
running Red Hat
Linux

319 MB

1.28 GB

638 MB

39 MB

x86-64 running
Red Hat Linux

Micro Focus

393 MB

1.57 GB

786 MB

50 MB

ppc64le running Micro Focus
Red Hat Linux

211 MB

844 MB

422 MB

1 MB

SPARC running
Solaris

Micro Focus

392 MB

1.57 GB

784 MB

41 MB

x86-64 running
Solaris

Micro Focus

368 MB

1.47 GB

736 MB

33 MB

System Z
running SUSE
SLES

Micro Focus

224 MB

896 MB

448 MB

39 MB

x64 running
SUSE SLES

Micro Focus

277 MB

1.11 GB

554 MB

50 MB

ppc64le running Micro Focus
SUSE SLES

191 MB

764 MB

382 MB

1 MB

Operating Systems Supported
For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.
Software Requirements
Note: This product includes OpenSSL version 1.0.2n.
Before installing this product, you must have the following software installed on your computer:
•
•

•

The "ed", "sed" and "tar" utilities must be installed and added to the PATH.
The pax archiving utility is required by the setup file. Pax is distributed with most UNIX/Linux systems
but, if it is missing, you must install it separately. To verify pax is installed, run pax --help or pax -version at the command line.
Required libraries for Red Hat and SUSE Linux platforms - The installer checks that both the 32-bit and
64-bit libraries listed below are installed on both 32-bit and on 64-bit Operating Systems for this product
to install and work correctly.
If installing on a 64-bit OS, the 32-bit libraries are not installed by default and must be installed before
you start the installation.
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Library

32-bit
Library
Name

64-bit
Library
Name

Platform
s390

SUSE 12¹

Red Hat 6.x

Red Hat 7

glibc

glibc-*.i686

glibc*.x86_64

glibc-*.s390

X

X

libgcc

libgcc-*.i686

libgcc*.x86_64

libgcc-*.s390

X

X

libstdc++

libstdc++*.i686

libstdc++*.x86_64

libstdc++*.s390

X

X

Visit the Red Hat Web site for more information.
¹ On SUSE 12, you can only install the 64-bit version of this product. The glibc-locale-32bit library is still
required by the SafeNet Sentinel licensed components.
•

Java 7, 8 (32 or 64-bit versions), and Java 9 (64-bit version only) are supported for executing JVM
COBOL code and for native COBOL and Java interoperability. You can download Oracle's Java from
Oracle's Web site and install it anywhere on your machine.
Note:
•

•
•

On AIX and zLinux, you need to have IBM's JDK. The earliest supported release of IBM's JDK
is 7.0 Service Refresh 8. If you install IBM's JDK 8, on AIX you must install its latest fix - JDK 8
SR5 FP16. You can get IBM's AIX JDK from IBM's Web site.
On HP-UX, you need to have HP-UX JDK. The earliest supported release of HP-UX is JDK
7.0.11. You can get the HP-UX Java JDK from HP's Web site.
On Solaris platforms (both SPARC and Intel) only the 64-bit version of Java 8 and later is
supported.

Before you start the installation, you need to set the environment as follows:
•
•

You need to set the LANG environment variable to pick up localized messages. The LANG settings are
English and Japanese only.
JavaScript or scripting support must be enabled in your browser, so that Enterprise Server
Administration is usable. Also, active content must be allowed and not blocked.
Important: For local servers, you do not need to install the Micro Focus License Administration tool
separately, as the setup file installs a new Visual COBOL client and a new licensing server on the
same machine.
If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool. To check the version of the license server on UNIX, run /var/
microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.
If Micro Focus License Manager version 10000.2.02070 or older is installed, it must be uninstalled
before the product installation or upgrade can continue.
You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

Additional Software Requirements on Linux and UNIX
To ensure full functionality for some COBOL Server features, you might be required to obtain and install
additional third-party software in addition to the prerequisite software installed automatically by the COBOL
Server setup file.
Click here to see this information on the Product Documentation pages on Micro Focus SupportLine.
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Browser
Back to Top
Browser versions which can be used for embedded browser support (such as SWT) and their
corresponding Eclipse versions are listed here.
Note: Eclipse 4.5 and newer support Mozilla 1.4 GTK2 - 1.7.x GTK2, XULRunner 1.8.x - 1.9.x, 3.6.x,
10.x, 24.x and 31.x (but not 2.x nor other unlisted versions), WebKitGTK+ 1.2.x and newer (Eclipse
4.5 support for XULRunner 31.x is not available on Linux due to Bug 467646.). For Eclipse 4.6 you
must install a 64-bit browser version.

UNIX and Linux Installer Issues
•

If you reinstall Visual COBOL for Eclipse on a UNIX machine, it is possible that Eclipse will start without
loading the Micro Focus features. To solve this, you must delete the .eclipse folder in your home
directory and restart Visual COBOL.

Installing while using AFS/Kerberos authentication
If you are using AFS/Kerberos authentication to log onto your Linux system then you need to ensure you
have a local user ID which SOA and Visual COBOL components of the product can use. This user ID must
be set up prior to running the installer. When running the installer you need to specify ESadminID=[User ID] on the command line so it is used by the installer.
License Server
You need to configure the computer hostname to ensure the license server will start properly.
To avoid performance issues, "localhost" and the computer hostname must not both be mapped to IP
address 127.0.0.1. You should only map "localhost" to IP address 127.0.0.1.
The following is an example of how to specify these entries correctly in the /etc/hosts file:
127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname
where IP is the unique IP address of the computer in xx.xx.xx.xx format.

Basic Installation
The instructions in this section apply when you are performing a basic installation of this product for the
first time. If you are an administrator, you can perform a basic installation on a local machine before
performing a more advanced installation when rolling out the product to developers within your
organization.
For considerations when installing this product as an upgrade, for additional installation options or nondefault installations, see Advanced Installation Tasks in your product Help.

Installing on Windows
Note: If there is an earlier version of COBOL Server installed on your machine, check Installing as an
Upgrade first.
These are the steps to install this product:
1. Run the cs_40.exe file and follow the wizard instructions to install the prerequisite software and the
product.
The setup file will also install any missing prerequisite software as listed in Software Requirements.
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Note:
•

•
•
•

If you are installing onto a machine that has an existing Micro Focus product that uses an older
Sentinel RMS License Manager, you might be prompted to remove it and install the Micro Focus
License Administration. By doing this you maintain the existing Sentinel RMS license files while
adding the Micro Focus License Administration. If you are unsure about existing licenses on your
computer or removing the Sentinel RMS License Manager, consult your System Administrator. If
you want to proceed, remove Sentinel RMS License Manager by using Add or Remove
Programs (Windows XP) or Program and Features (Windows Vista or later), and rerun the
installation file.
Trial licenses cannot be used with remote desktop services. If you want to use your product in this
way, please contact Micro Focus SupportLine to obtain a relevant license.
We recommend that you install any updates for the .NET Framework that are available at the
Microsoft Download site.
If you install JDK you might be prompted to install the latest update. The latest update is not
required for use with COBOL Server but you can install it if you wish.

Installing on UNIX
Note: Micro Focus offers two types of installers on UNIX and Linux - a proprietary Micro Focus
installer for installing on UNIX and Linux and a standard RPM (RPM Package Manager) installer for
installing on Linux. See your product Help for instructions on how to use the RPM installer.
These are the steps to install this product using the Micro Focus installer:
1. Give execute permissions to the setup file:
chmod +x setup_cobol_server_4.0_platform
2. Run the installer with superuser permissions:
./setup_cobol_server_4.0_platform
If you don't run this as superuser, you are prompted to enter the superuser password during the install.
If you set COBDIR to an already installed product, the installer will back up the existing installation and
will install this release in the location COBDIR points to. If COBDIR is not set, the installer does a fresh
install.
The COBOL run-time is installed by default into /opt/microfocus/VisualCOBOL, (COBDIR).
SafeNet Sentinel considerations
•

•

The installation of this product could affect the SafeNet Sentinel licensed components running on your
machine. During installation licensing is shutdown to allow files to be updated. To ensure the processes
running on your machine are not affected, you need to use the -skipsafenet option, which skips the
installation of SafeNet:
./setup_cobol_server_4.0_platform -skipsafenet
To protect the SafeNet Sentinel installation from accidental updating you can create an empty file
named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:
touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL
While the file is present, the SafeNet installer does not make changes to the installation or shutdown the
running license daemons. If licensing needs to be updated later, remove the file and install Sentinel
RMS server manually.

Advanced Installation Tasks (Windows)
This section includes instructions about how to perform a non-default installation, install this product as an
upgrade, or about how to install any additional components.
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The advanced installation tasks include:
•
•

Installing as an Upgrade
Command line installation options

Click here to see this information on the Product Documentation pages on Micro Focus SupportLine.

Installing as an Upgrade
Before installing, check Installation Restrictions and Requirements.
Installing this release as an upgrade will automatically uninstall any HotFixes of the older version of the
product you have installed on your machine.
•

Before installing this release as an upgrade, ensure you create a back-up of your Enterprise Server
configuration. To do this, on the Enterprise Server Administration home page, click Export and then
select Export Enterprise Server configuration and Security Manager definitions. This creates a
backup folder in the c:\programdata\micro focus\Enterprise Developer\MFDS. You can
restore the Enterprise Server configuration after installing this release - click Import on the Enterprise
Server Administration home page.

COBOL Server Installation Options
To install COBOL Server you run cs_40.exe which contains a number of product .msi files (Windows
Installer packages). When run, cs_40.exe performs some initial system checks then sequentially installs
the .msi files.
cs_40.exe can take a number of parameters, enabling you to specify a number of different types of
installation:
•

Standard Installation

•

Format:
cs_40.exe
Summary:
Full installation including License Manager and COBOL Server. During installation you can specify
options including the location to which the components are installed.
Non-interactive Installation

•

Format:
cs_40.exe /passive
Summary:
Full installation, but the components are installed non-interactively using default options and
directories.
Silent Installation

•

Format:
start /wait cs_40.exe /q
Summary:
Full installation, but the components are installed non-interactively with no user interface, using
default options and directories.
Modified Silent Installation
Format:
start /wait cs_40.exe /q InstallFolder=d:\cobolrts
Summary:
Full installation, but the components are installed non-interactively with no user interface, and
COBOL Server is installed to d:\cobolrts.
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To see what parameters you can use, execute the following from the command line: cs_40.exe /?.
Note:
•

Log files that are created during installation are saved in the folder specified by the TEMP
environment variable. To change the location or name of the files, use the /log parameter on your
setup command line and specify the path and file name, for example: filename /log d:\temp
\log.txt. This creates a log file, named log.txt, in the d:\temp directory.

Advanced Installation Tasks (UNIX)
This section includes instructions about how to perform a non-default installation, install this product as an
upgrade, or about how to install any additional components.
The advanced installation tasks include:
•
•
•

Installing as an Upgrade - included in these Release Notes
Command line installation options - included in these Release Notes
Installing using an RPM installer on Linux - available in the product Help and in the Micro Focus
Infocenter

Click here to see this information on the Product Documentation pages on Micro Focus SupportLine.

Installing as an Upgrade
This release works concurrently with the previous version of COBOL Server, so you do not need to
uninstall it.
Install the latest version in a different location and set the environment to point to it. To do this, run the
COBOL Server installer with the –installlocation option:
1. Execute the following command:
./InstallFile -installlocation="/opt/microfocus/VisualCOBOL"
Note: You can use variables when specifying an absolute path for –installlocation. For
example, the following examples are equivalent:
-installlocation="/home/myid/installdir"
-installlocation="$HOME/installdir"
2. Execute cobsetenv to set the environment and point to the new install location:
. <product-install-dir>/bin/cobsetenv
Note: cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Installation Options
Installing into a different location
To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:
./ -installlocation="full path of new location"
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Note: You can use variables when specifying an absolute path for –installlocation. For
example, the following examples are equivalent:
-installlocation="/home/myid/installdir"
-installlocation="$HOME/installdir"
You can see details about which additional parameters can be passed to the install script if you enter the help option.
Configuring Enterprise Server
You can use the following options to configure the Enterprise Server installation: [ -ESsysLog="Y/N" ]
[ -ESadminID="User ID" ] [ -CASrtDir="location" ], where:
-ESsysLog

Use this to enable ("Y") or disable ("N") Enterprise Server system logging. Logging is
enabled by default. Log files are saved in /var/mfcobol/logs.

-ESadminID Sets the Enterprise Server System Administrator Process User ID from the command line for example, -ESadminID="esadm". The default user ID is the one that runs the installer.
-CASrtDir

Specifies the location were the Enterprise Server run-time system files are placed - for
example, -CASrtDir="/home/esuser/casrt/es". The default location is /var/
mfcobol/es.

Installing Silently
You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install. You must execute the command with superuser
permissions.
You can use the following command line arguments to install silently on UNIX/Linux. You need to execute
the commands as root:
–silent -IacceptEULA
For example, execute:
setup_filename –silent -IacceptEULA

After Installing
•
•

See Changes in Behavior or Usage in your product documentation and in the Release Notes for
important information about changes in this release that might affect existing applications.
Check the Product Documentation section of the Micro Focus SupportLine Web site for any updates to
the documentation which might have been uploaded.

On Windows
To access the COBOL Server help:
•

On versions of Windows 7 and earlier, select Start > All Programs > Micro Focus COBOL Server
2013 > Documentation from the Windows Taskbar.

•

On Windows 8, right-click at the bottom of the Start screen, and click All apps to display all available
links for this product. In the COBOL Server section, click Documentation.

This opens the online Micro Focus Infocenter in a browser. From the left-hand pane, select Micro Focus
Developer > Micro Focus COBOL Server.
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Repairing
If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.
To repair your installation on versions of Windows Vista or later:
1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.
To repair your installation on older versions of Windows, such as Windows XP:
1.
2.
3.
4.

Click Start Menu > Control Panel > Add/Remove Programs.
Click your Micro Focus product in the list of installed programs.
Click Click here for support information.
Click Repair.

Uninstalling
To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:
1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs (or Add/Remove Programs on older versions of
Windows) in Control Panel.
3. On older versions of Windows such as Windows XP, ensure that Show Updates (at the top of the Add
or Remove Programs dialog) is checked, so that any hot fixes or WrapPacks are listed.
4. Select the product and click Remove or Uninstall as appropriate.
When you uninstall, the only files deleted are those that the installation software installed. If the product
directory has not been removed, delete any unwanted files and subdirectories within it using Windows
Explorer.
Important: The installer creates separate installations for Micro Focus COBOL Server and Micro
Focus License Administration. Uninstalling only COBOL Server does not automatically uninstall the
Micro Focus License Administration or any of the prerequisite software.
To completely remove the product you must uninstall the Micro Focus License Administration as well.
You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
To silently uninstall the product, you need the setup file and you need to execute the following at the
command line:
start /wait install-file.exe /quiet /uninstall

On UNIX
Setting the Environment
When you have installed the product, you need to set the environment as described below.
1. To set up your product, execute:
. <product-install-dir>/bin/cobsetenv
2. To verify that your product is installed, execute:
cob -V
Important: These commands set the environment only for the current shell. You need to execute
them for each new shell that you start.
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To avoid having to run cobsetenv for every shell, add these commands to the shell initialization files
(such as /etc/profile, /etc/bashrc).
Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Repairing
If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.

Uninstalling
Note: Before you uninstall the product, ensure that the Enterprise Server instances and the Micro
Focus Directory Service (MFDS) are stopped.
To uninstall this product:
1. Execute as root the Uninstall_COBOLServer4.0.sh script in the $COBDIR/bin directory.
Note: The installer creates separate installations for the product and for Micro Focus License
Administration. Uninstalling the product does not automatically uninstall the Micro Focus License
Administration or the prerequisite software. To completely remove the product you must uninstall the
Micro Focus License Administration as well.
To uninstall Micro Focus License Administration:
1. Execute as root the UnInstallMFLicenseServer.sh script in the /var/
microfocuslicensing/bin directory.
The script does not remove some of the files as they contain certain system settings or licenses.
You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
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Licensing Information
Note:
•
•
•

If you have purchased licenses for a previous release of this product, those licenses will also
enable you to use this release.
The latest version of the SafeNet licensing software is required. See the Software Requirements
section in this document for more details.
If you are unsure of what your license entitlement is or if you wish to purchase additional licenses,
contact your sales representative or Micro Focus SupportLine.

To buy and activate a full unlimited license
To buy a license for Visual COBOL, contact your sales representative or Micro Focus SupportLine.
For instructions on using the Micro Focus Licensing Administration Tool, see Licensing in the Visual
COBOL help.

To start Micro Focus License Administration
Windows 8, 8.1, and Windows •
Server 2012

From the Windows Start screen, click the License Administration
tile

Windows 10 and Later

From your Windows desktop, click Start > Micro Focus License
Manager > License Administration

•

Log on as root, and from a command prompt type:
/var/microfocuslicensing/bin/cesadmintool.sh

Installing licenses
You need either a license file (with a .mflic extension) or an authorisation code which consists of a string
of 16 alphanumeric characters.

If you have a license file
1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Do one of the following:
•

Click Browse next to the License file field and select the license file (which has an extension
of .mflic).
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•
•

Drag and drop the license file from Windows Explorer to the License file field.
Open the license file in a text editor, such as Notepad, then copy and paste the contents of the file
into the box below the License file field.
4. Click Install Licenses.

1. Start the Micro Focus License Administration tool and select the Manual License Installation option by
entering 4.
2. Enter the name and location of the license file.

If you have an authorization code
Authorizing your product when you have an Internet connection
Note:
•

It is not possible to install licenses remotely. You must be logged into the machine on which you
are installing the licenses.

The following procedure describes how to authorize your product using a local or network license server.
The license server is set up automatically when you first install the product.

1.
2.
3.
4.

Start Micro Focus License Administration.
Click the Install tab.
Type the authorization code in the Enter authorization code field.
Click Authorize.

If you change the name of the machine running your license server after it has granted licenses, the
licenses stop working.

1. Start Micro Focus License Administration.
2. Select the Online Authorization option by entering 1 and pressing Enter.
3. Enter your authorization code at the Authorization Code prompt and then press Enter.

Authorizing your product when you don't have an Internet connection
This method of authorization is required if the machine you want to license does not have an Internet
connection or if normal (automatic) authorization fails.

1.
2.
3.
4.

Start Micro Focus License Administration.
Click Manual Authorization on the Install page.
Make a note of the contents of the Machine ID field. You will need this later.
Do one of the following:
•
•

If your machine has an Internet connection, click the SupportLine Web link in the Manual
Authorization Information window.
If your machine does not have an Internet connection, make a note of the Web address and type it
into a Web browser on a machine that has an Internet connection.

The Micro Focus SupportLine Manual product authorization Web page is displayed.
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5. Type the authorization code in the Authorization Code field. The authorization code is a 16-character
alphanumeric string supplied when you purchased your product.
6. Type the Machine ID in the Machine ID field.
7. Type your email address in the Email Address field.
8. Click Generate.
9. Copy the generated license string (or copy it from the email) and paste it into the box under the License
file field on the Install page.
10.Click Install Licenses.

In order to authorize your product you must have the following:
•
•
•

Access to a computer which is connected to the Internet.
Your authorization code (a 16-character alphanumeric string).
The machine ID. To get this, start the Micro Focus License Administration tool and select the Get
Machine Id option by inputting 6. Make a note of the "Old machine ID".

If you have previously received the licenses and put them in a text file, skip to step 6.
1. Open the Micro Focus license activation web page http://supportline.microfocus.com/activation in a
browser.
2. Enter your authorization code and old machine ID and, optionally, your email address in the Email
Address field.
3. Click Generate.
4. Copy the licenses strings from the web page or the email you receive into a file.
5. Put the license file onto your target machine.
6. Start the Micro Focus License Administration tool and select the Manual License Installation option by
inputting 4.
7. Enter the name and location of the license file.

To obtain more licenses
If you are unsure of what your license entitlement is or if you wish to purchase additional licenses for Visual
COBOL, contact your sales representative or Micro Focus SupportLine.
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Updates and SupportLine
Our Web site gives up-to-date details of contact numbers and addresses.

Further Information and Product Support
Additional technical information or advice is available from several sources.
The product support pages contain a considerable amount of additional information, such as:
•
•
•

The Product Updates section of the Micro Focus SupportLine Web site, where you can download fixes
and documentation updates.
The Examples and Utilities section of the Micro Focus SupportLine Web site, including demos and
additional product documentation.
The Support Resources section of the Micro Focus SupportLine Web site, that includes troubleshooting
guides and information about how to raise an incident.

To connect, enter http://www.microfocus.com in your browser to go to the Micro Focus home page, then
click Support & Services > Support Resources > All Support Resources. In the Browse by Product
field, click the product you require support for. Click Log into SupportLine.
Note: Some information may be available only to customers who have maintenance agreements.
If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, www.microfocus.com. If you obtained the product from another source, such as an authorized
distributor, contact them for help first. If they are unable to help, contact us.
Also, visit:
•

•

The Micro Focus Community Web site, where you can browse the Knowledge Base, read articles and
blogs, find demonstration programs and examples, and discuss this product with other users and Micro
Focus specialists. See http://community.microfocus.com.
The Micro Focus YouTube channel for videos related to your product - see https://www.youtube.com/
user/MicroFocusIntl.

Information We Need
However you contact us, please try to include the information below, if you have it. The more information
you can give, the better Micro Focus SupportLine can help you. But if you don't know all the answers, or
you think some are irrelevant to your problem, please give whatever information you have.
•
•
•
•
•
•

The name and version number of all products that you think might be causing a problem.
Your computer make and model.
Your operating system version number and details of any networking software you are using.
The amount of memory in your computer.
The relevant page reference or section in the documentation.
Your serial number. To find out these numbers, look in the subject line and body of your Electronic
Product Delivery Notice email that you received from Micro Focus.

On Windows, if you are reporting a protection violation you might be asked to provide a dump ( .dmp) file.
To produce a dump file you use the Unexpected Error dialog box that is displayed when a protection
violation occurs. Unless requested by Micro Focus SupportLine, leave the dump setting as Normal

52

| Updates and SupportLine

(recommended), click Dump, then specify a location and name for the dump file. Once the dump file has
been written you can email it to Micro Focus SupportLine.
Alternatively, you might be asked to provide a log file created by the Consolidated Tracing Facility (CTF) - a
tracing infrastructure that enables you to quickly and easily produce diagnostic information detailing the
operation of a number of Micro Focus software components.
On Windows, you can use the Micro Focus SupportLine Support Scan Utility, MFSupportInfo, to create
either:
•
•

a .log file that contains the details about your environment, Micro Focus SupportLine products, and
settings.
a .zip archive that includes the same information as the .log file plus some product configuration
files from c:\ProgramData and the product installation log files.

MFSupportInfo.exe is stored in <install-dir>\bin.
To run MFSupportInfo:
1. Start a 32-bit Enterprise Developer command prompt.
2. Enter MFSupportinfo at the command prompt to start the utility.
3. Create a .log file or a .zip archive as follows:
a. To create a .log file, click File > Save.
This prompts to save the .log file, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MMSS.log, in the %temp% directory.
b. To create a .zip archive, click Tools > Create Zip Package.
This creates a .zip archive, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MMSS.zip, in the %temp% directory.
4. Send the diagnostic information to your Micro Focus SupportLine representative:
The following requires an Internet connection and an Email client:
a. Click Tools > Email Log to SupportLine to open the Email Log dialog box.
b. Fill in the required fields and click Send.
If the machine is not connected to the Internet or if there are no Email clients installed, copy either
the .log file or the .zip archive to a machine that is connected to the Internet. Use your Email client
to email the files to Micro Focus SupportLine at supportline@microfocus.com together with the Support
Incident (SI) number, if available, and any additional details that might be useful to diagnose the issues
that you are experiencing.
On UNIX, you can use the Micro Focus UNIX Support Scan Utility, mfsupport, to create a log file that
contains the details about your environment, product, and settings. The mfsupport script is stored in
$COBDIR/bin.
To run mfsupport:
1. Start a UNIX shell.
2. Set COBDIR to the product with issues.
3. Execute mfsupport from a directory where you have write permissions.
This creates a log file, mfpoll.txt, in that directory.
4. When the script finishes, send the mfpoll.txt file to your Micro Focus SupportLine representative.
Note:
If COBDIR is set to a location that does not contain etc/cobver, the script outputs the contents
of /opt/microfocus/logs/MicroFocusProductRegistry.dat which keeps a list of the
installed Micro Focus products.
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Creating Debug Files
If you encounter an error when compiling a program that requires you to contact Micro Focus SupportLine,
your support representative might request that you provide additional debug files (as well as source and
data files) to help us determine the cause of the problem. If so, they will advise you how to create them.
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Copyright and Disclaimer
©

Copyright 2019 Micro Focus or one of its affiliates.

The only warranties for this product and any associated updates or services are those that may be
described in express warranty statements accompanying the product or in an applicable license agreement
you have entered into. Nothing in this document should be construed as creating any warranty for a
product, updates, or services. The information contained in this document is subject to change without
notice and is provided "AS IS" without any express or implied warranties or conditions. Micro Focus shall
not be liable for any technical or other errors or omissions in this document. Please see the product's
applicable end user license agreement for details regarding the license terms and conditions, warranties,
and limitations of liability.
Any links to third-party websites take you outside Micro Focus websites, and Micro Focus has no control
over and is not responsible for information on third party sites.
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